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1. Introduction 
This document describes the differences between the Adobe Reader and PureEdge (PE) viewer 
forms used on Grants.gov. Basic questions asked about mandatory fields, help tip/error messages, 
date fields, numeric fields, and attachments are answered specifically.  
 
Grants.gov is transitioning from PureEdge to Adobe Reader for a more simplified approach for the 
users. Grants.gov requires downloading both PureEdge and Adobe Reader to seamlessly apply for 
grants. To ensure you have the Grants.gov compatible version, visit the download software page at: 
http://www.grants.gov/help/download_software.jsp 
 
Grants.gov is currently phasing out of PureEdge software to using Adobe Reader software 
exclusively. For a period of time applicants will still be able to use PureEdge as it is applicable. 
 

2. Grants Applicant Transition Questions regarding Adobe Reader 
 
What do I need to install on my personal computer in order to use the new Adobe Reader 
Forms that are replacing PureEdge? 
 
To view and complete an Adober Reader Grants.gov Application Package, click here: 
http://www.grants.gov/help/download_software.jsp to download the compatible version of the Adobe 
Reader software. There is no cost to the users to download, install or use the Adobe Reader 
software. 
 
What if I have an existing incomplete grant application package that uses PureEdge and still 
needs to be submitted? 
 
Grants.gov will continue to accept and process PureEdge application packages that are posted to the 
website. You may complete the existing Grant Application Package using the PureEdge viewer and 
submit the completed application on or before the posted opportunity close date or agency receipt 
deadline. If you are unsure about the process for a specific opportunity, please review and follow the 
application submission instructions provided by the grantor agency. 
 
Will applicants be required to submit PDF attachments only? 
 
No. Grants.gov will continue to accept attachment documents in various files types. Applicants should 
always thoroughly read each funding opportunity's application instructions which may require a 
specific attachment file type. 
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What is the Grants.gov compatible version of Adobe Reader software?  
 
There are specific versions of Adobe Reader software that are compatible with Grants.gov. If not 
already installed, please download and install the free Grants.gov compatible version of Adobe 
Reader. To view the compatible versions of Adobe Reader visit: 
http://www.grants.gov/help/download_software.jsp#adobe811.  
 
What if I have an older version (v8.1.1or less) of Adobe Reader? 
 
Older versions of the Adobe Reader may be able to display the application package; however, data 
entry forms in Grants.gov application packages contain intelligent logic that the older versions of 
Adobe Reader will not be able to interpret. You may not be able to complete application packages 
correctly or successfully submit them to Grants.gov. 
 
What if I have a newer version (higher than v8.1.1) of Adobe Reader? 
 
Adobe Reader 8.1.2 is the currently recommended compatible version for use with Grants.gov; 
however Adobe Reader 8.1.1 is compatible as well. Using versions of Adobe Reader other than the 
Grants.gov compatible versions to submit your application package may be rejected during 
processing by the Grants.gov system, causing delay in your submission and/or acceptance by the 
granting agency. 
 
On what platforms can I use the Adobe Reader to view and populate Grants Packages? 
 
The Grants.gov compatible Adobe Reader version is supported by all Windows platforms including: 
Windows 2000 with Service Pack 2, Windows XP Professional or Home Edition, Windows XP Tablet 
PC Edition and Vista. The Grants.gov compatible Adobe Reader version is also supported by the 
following Non-Windows platforms: all Mac OS X v.10.5 or earlier including Tiger and Leopard, Linux, 
AIX, HP/UX, and Solaris platforms. Please see Operating System Compatibility Table below for all 
Grants.gov platform compatibility. 
 
Please note, Grants.gov does not recommend use of handheld devices such as Palm to complete 
electronic application packages downloaded from Grants.gov. 
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Operating System Compatibility Table 

Computer Operating System Forms Program Compatible May Use System with  
Citrix Server Connection 

Mac Tiger IBM Workplace Forms Viewer Yes   

Mac Tiger PureEdge Viewer No Yes 

Mac Tiger Adobe Reader 8.1.2 Yes   

Mac Leopard IBM Workplace Forms Viewer No Yes 

Mac Leopard Adobe Reader 8.1.2 Yes   

PC WINXP PureEdge Viewer Yes   

PC WINXP Adobe Reader 8.1.2 Yes   

PC Vista IBM Workplace Forms Viewer No Yes 

PC Vista PureEdge Viewer No Yes 

PC Vista Adobe Reader 8.1.2 Yes   

 
As a Grantor, Principal Investigator, Business Manager, or Research Office Staff, do I need 
any additional Adobe software (other than the Adobe Reader) in order to generate or process 
a Grant Application Package? 
 
You may need additional software programs (e.g. Wordperfect, Microsoft Word, etc.) to open, view 
and/or print attachments submitted by the applicants along with their applications.  
 
I tried to open a Grants Application Package using Adobe v5.1 and the Adobe Reader 
displayed “There was an error opening this document. This file is damaged and could not be 
repaired.” Why is this happening? 
 
The grants application package was developed with intelligent logic at the form field level. You must 
use the Grants.gov compatible version of Adobe Reader to view and populate the grants application 
package correctly. Other versions of Adobe Reader may lead to errors and prevent you from 
submitting your application to Grants.gov in a timely manner. 
 
To view the compatible versions of Adobe Reader visit: 
http://www.grants.gov/help/download_software.jsp#adobe811. 
 
What should my settings be on the compatible version of Adobe Reader? 
 
Settings should be set to a background other than yellow, single page view, and form sizing greater 
than 75%. Unlike the PureEdge version, the Adobe Reader has the ability to set background shading, 
which could create confusion because the mandatory fields in PureEdge application packages have 
yellow highlighting while the newer Adobe PDF based application packages have a yellow 
highlighting with a red border. 
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3. Navigation Issues 
 
When I open an application package in Adobe Reader, I get a window titled “Document Rights 
and Instructions.” It says “You need a newer version of Acrobat.” The Grants.gov compatible 
version of Adobe Reader is the recommended version to currently use. 

If this message displays simply download the Grants.gov compatible version of Adobe Reader here: 
http://www.grants.gov/help/download_software.jsp#adobe811 and set the Adobe Reader as your 
default viewing software by following the instructions detailed in this FAQ: How can I ensure I am 
using Adobe Reader to work on my application package? 
http://www.grants.gov/applicants/applicant_faqs.jsp#83. 

 
How do the PureEdge version and the Adobe version differ on basic navigation between 
pages? 
 
In PureEdge, the 'Previous' and 'Next' buttons are always present at the top of the form. In the Adobe 
Reader application packages, these buttons are part of the form, so they 'move up the page' as you 
progress to the bottom and are not always visible. The Adobe Reader also allows scrolling from one 
form to the next, without requiring you to use the 'Previous' and 'Next' buttons.  
 
Figure 1: PureEdge Navigation Page 
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Figure 2: Adobe Navigation Page 

 
 
The Save Form option is displayed even though I opened the Grants Package and did not 
change any data. The information message “Do you want to save changes to the name.pdf 
before close?” is displayed. Why? 
 
Many of the fields found on each form page contain intelligent logic. Tabbing or navigating through 
any field will trigger this message. It is good practice to save the application package frequently 
during the course of entering data by clicking on the “Save” button (scroll all the way to the top if the 
button is not visible) or when prompted. 
 
I entered data into one field in my grants application package, however, the Save icon is not 
active. Why? 
 
You have not exited this form field yet. Once you tab to another field, the active intelligent logic 
validating that form field will be triggered, and also trigger Adobe Reader that something has changed 
in the form. Simply move the cursor to another field using the Tab key or the mouse. 
 
The cursor position appears lost when I tab from the Close and Next Page buttons. Why? 
 
If no fillable form fields exist on this form page, navigation is passed to the scroll bar on the next 
page. Simply use the mouse to navigate to the next fillable field. 
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The cursor position is lost when I try to move the cursor to the first fillable form field on a 
second (or subsequent) page while viewing the Adobe Reader in “Continuous” form mode. 
Why? 
 
Adobe Reader has four types of viewing modes – single page, continuous, continuous facing and 
facing. Always specify single page mode. To set page layout do one of the following: 

o Choose View > Page Layout, and then choose Single Page. 
o Click the Single Page button in the status bar. 

 
If necessary, choose View > Fit Page to display the document in the current page layout. There is a 
known bug in Adobe Reader versions other than the Grants.gov compatible version; in continuous 
mode where the cursor position will be lost. If you are unable to download the Grants.gov compatible 
version of Adobe Reader, simply use the mouse to navigate to another form field on that page, and 
then back to the first enterable form field on that page. 
 
The Tab key only takes me to the first radio button where I can only choose one option (i.e., 
Yes or No). Why? 
 
The Adobe Reader form technology utilizes check box groups. These groups are used when the user 
is limited to one choice out of two or more choices such as Yes/No. Adobe Reader will only position 
the cursor on the first check box choice. You can use either the arrow keys or the mouse can be used 
to navigate to the remaining choices. 
 
Figure 3: Navigation Issues (check boxes) 
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In the Adobe Reader application package, the View Attachment pop-up window has three 
options, but the Tab key does not move the cursor. Why? 
 
As explained in the previous question, it is best to navigate and select the correct check box using the 
mouse. 
 
When a supplementary form is added from within a form (as in Research and Related grant 
packages used by several agencies (e.g. National Institute of Health (NIH), Department of 
Education, etc.), how do the versions differ? 
 
In the PureEdge version of application packages the user is directed to initiate another form and add 
it as an attachment to the application package. In the Adobe Reader version the original form is 
repeated, adding one or more pages to the end of the package. You get to the first of the ‘new’ pages 
by using the mouse scroll bar, the side scroll bar, or the Adobe Reader next page arrow at the 
bottom.  
 

4. Viewing and Populating Forms 
This section is split into five categories: Mandatory Fields, Help Tips/Error Messages, Date Fields, 
Numeric Fields, and Attachments. In each of these five sections, the difference between use of 
Adobe Reader and PureEdge viewer is explained. 
 
Mandatory Fields: 
 
How are mandatory fields in Adobe Reader different from the PureEdge viewer? 
 
Mandatory fields in Adobe Reader are highlighted in yellow with a red border. The red border is to 
ensure that if a yellow highlight is accidentally set throughout on form by the user through Adobe 
Reader preferences, the mandatory fields will still show up highlighted. All red border fields are 
considered mandatory. 
 
Why are non-mandatory fields becoming mandatory in my Adobe Reader application and 
causing errors when I try to submit my application package? 
  
Certain fields within your application package are conditionally mandatory; which means that your 
answer in one field determines whether another field becomes mandatory and requires an answer. 
Using the Select Tool (a standard feature in Adobe Reader application forms) instead of the Hand 
Tool  (hand-like mouse pointer) designated for use with Grants.gov application forms, will make non-
mandatory fields mandatory or prevent you from entering information into certain fields. Using the 
Select Tool will cause errors during the Check Package for Errors screening you must perform 
before you can submit the completed application. If this error occurs, close and simply reopen the 
application, you will then be able to complete the application package and submit it as normal.  
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If the Select Tool persists after re-opening the application package, use the instructions below to 
reset the Hand Tool: 

1. Go to Tools menu at the top of the screen 
2. Choose Select & Zoom  
3. Select Hand Tool from the pop-up menu 

 
 
Help Tips/Error Messages: 
 
How do I display a Help Tip in my Adobe Reader application package? 
 
To display a Help Tip in Adobe Reader, simply hover (or place) the cursor over the field in question 
using the mouse or other navigation aid. 
 
Figure 4: Help Tips 

 
 
Why are Help Tips missing on some fields? 
 

a) Some fields that are forward-populated from the main SF424 form or some sub-forms are 
display-only fields. Users cannot access these fields through the Tab key or mouse navigation. 
Since the user cannot enter data into this field, no Help Tip is available. 

b) Some buttons are grayed-out meaning they are not active. Help Tips are not displayed for 
these buttons until the buttons become active. Active buttons are bright and Help Tips for them 
are displayed when the mouse hovers over the button. 

 
 
 
Why do I get error messages in some form fields by simply tabbing through them even before 
I enter any data in them? 
 
Error messages will be displayed in a separate “pop-up” window anytime mandatory data is required 
for that field. The Adobe Reader forms technology uses active intelligent logic to validate and inform 
the user of errors upon exiting a mandatory data entry field. 
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Figure 5: Error Messages 

 
 
 
 
 
Date Fields: 
 
How do date fields differ from the PureEdge version? 
 
The PureEdge viewer requires a formatted date field. The Adobe Reader has the option of a ‘drop 
down’ calendar, which can be navigated by mouse, if desired.  
 
The Adobe Reader also accepts an entered date format. The following are the only valid date 
formats: MMDDYY, MMDDYYYY, MM/DD/YY or MM/DD/YYYY. All other variations of date entries 
will display an error message. Please note that fiscal year only fields (YYYY) are not “true” date fields. 
 
Figure 6: Date ‘Drop Down’ Field 

 
 
 
Numeric Fields: 
 
How does numeric field editing differ between versions? 
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In the PureEdge version, if you enter numbers incorrectly the system will place a comma every three 
places regardless of whether it is correct. The Adobe Reader version will either blank out or truncate 
the field. If you enter data without commas, the Adobe Reader will insert commas appropriately. The 
user should always verify all numeric entries for accuracy. 
 
Attachments: 
 
Can I use the native Adobe Reader attachment function, through the Adobe Reader menu or 
icon to attach documents to the application package? 
 
No. Only use the attachment buttons found on the application form. While the native Adobe Reader 
attachment function may appear to work, certain application logic has been included in the 
Grants.gov application packages to remove these attachments upon submission. This is to ensure 
that all attachments can be associated with an appropriate data entry field in the application package. 
 
 
 
 
Figure 7: Adobe Attachment Function 

 
 
The attachment function failed to attach my document. Why? 
 
The document or artifact you were attempting to attach is open or being used by another software 
application. Close the document or artifact using the other software application (i.e., Word, Excel, 
etc.) before attaching the document. 
 
I cannot view my attachment and the Adobe Reader displays an error message “Acrobat 
security settings do not allow this type of file to be opened.” How do I view it? 
 
The Adobe Reader security settings do not allow opening file(s) that could execute code on your 
personal computer as a safety precaution to prevent software viruses. This security setting includes 
Zip file and about 50 other types of files. 
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I accidentally selected the “Do not open the file with this extension?” selection (radio button) 
when I was trying to view an attachment. Now, I cannot view any documents with this file 
extension (i.e., .doc, .xls, etc.) How do I undo this? 
 
You can reset the file extensions back to the Adobe Reader defaults. From the Adobe Reader menu, 
select Edit and Preferences. From Preferences pop-up window, select Trust Manager from the 
categories listed down the left side. Select the button at the bottom of the window that says “Reset 
list of allowed/disallowed file attachment types”. Then click on the OK button in the lower right 
corner. Your viewing capabilities of form attachments will be reset to the Adobe Reader defaults. 

 

5. Submitting Completed Application Packages 
 
I have completed all the fields and forms of my Adobe Reader application package but the 
“Save & Submit” button remains inactive (grayed out) and I cannot submit my package. 
 
Click on Check Packages for Errors. If all fields pass validation checks you will see a message box 
saying “Validation Passed”. Click OK. The Save & Submit button should now become active, you will 
need to save your application package once more and then you will be able to submit your completed 
application package. If your application package fails the validation screening, then fix the error(s) 
and try again. 
 
When I click on the “Save & Submit” button to submit an application package, I see a message 
window popup summarizing details of the application. I clicked OK. The Adobe Reader 
presented another window with User Name and Password prompt. Which user ID and 
password should I enter? 
 
Enter your Authorized Organization Representative (AOR) user ID and password as registered with 
Grants.gov.  
 
I entered my AOR user name and password. I get a pop-up window that says “This document 
is trying to connect to the site: http://apply.grants.gov/services/LoginWS?wsdl. If you trust the 
site click ‘Allow’, otherwise click ‘Block’. Should I click on ‘Allow’ or ‘Block’? 
 
Click on ‘Allow’ and select the checkbox next to ‘Remember my Action…’ This is a security warning 
from the Adobe Reader. Please note the URL shown in the window may be slightly different than 
what is listed here. 
 
I accidentally clicked on ‘Block’ and also selected the checkbox. Now I am unable to submit 
completed application packages. What should I do? 
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Click on Edit->Preferences in Adobe Reader and then on ‘Trust Manager’ in the left hand pane. Click 
on ‘Change Site Settings.’ On the ensuing window, select any sites listed in the site list which are 
related to Grants.gov and remove them one at a time. Click on OK until you get out of the preferences 
windows. Now try submitting again only this time click on ‘Allow’ on the pop-up window. 
 
 
NOTICE: 
Please be aware of the following two issues when using Adobe Reader as you complete your 
application: on occasion the cursor may jump to the top of the form when you move a document to 
the mandatory document list. Also, there is no visual focus when you first tab into the list of available 
documents until the down arrow is used. 
 
Grants.gov is working on this issue and strives to ensure site accessibility for all of its users. Our goal 
is not only to meet but exceed 508 compliance standards. If users experience any difficulties with 
accessing the forms contained with an application package, please contact the Grants.gov Contact 
Center at   
1-800-518-4726. 
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